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Install 
The Realmagazine is a preset that comes as standard .c4d files, which means it can be opened like 
a regular project file and copied to your own scene. The most convenient method is to install a 
preset directly in the Content Browser: 

1. Open the Content Browser ( Window > Content Browser... ). 
2. Create a new preset library ( File > New Preset Library... ) and give it a name. 
3. Drag the .c4d preset file from the product folder into that new preset library. 
4. Optional: Right-click to define a thumbnail ( Set Preview... ) or to rename the preset. 
5. The preset is now saved in the Content Browser. Just drag it into your project from there. 

 

Introduction 
The following is a short manual of Realmagazine, a Cinema 4D preset. It is fully compatible with 
Cinema 4D R20. It also works with the R17, R18 and R19 but with a limitation: the Remove Bends 
Artifacts command of the Render tab, which is useful for removing some artifacts in more complex 
configurations, doesn’t work since these versions do not include the new Fields feature of C4D R20 
and if you save the project with these releases you will lose this feature. 

Before seeing in detail all the controls I want to explain the basics of its operation. In this way it will 
be possible to understand what to expect from the preset and to deduce if it can be useful or not 
for your project. 
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Fig. 1 – External sheet 

As with real versions of magazines, newspapers, notebooks and exercise books, Realmagazine 
consists of a set of folded sheets inserted one inside the other. The outer sheet (fig.1) contains all 
the inner sheets folded in half and creates with them a stack of sheets. Each sheet in the preset 
consists of two adjacent objects: two parametric cubes or, as I suggest for optimization reasons, two 
custom polygons created ad hoc by the user (or taken from those made available). So every single 
sheet is divided into two pages: Page.SX and Page.DX. Each page has two faces, front and back, and 
therefore two polygon selections to which the front and back textures can be attributed 
respectively. Summarizing for each sheet are associated 4 polygon selections and 4 materials 
(SX.Front, SX.Back, DX.Front, DX.Back) as illustrated in figure 2. 
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fig.2 – Materials positioning 

The external sheet gives the main shape to the Realmagazine so it is important to understand the 
meaning of some user data connected to it. The first two, of considerable importance, are: Base 
Rotation Size in the Dimension tab and Base Rotation in the External Sheet tab. The Base Rotation 
Size indicates the portion of the page, called Base, on which, acting on the Base Rotation, the 
Realmagazine can roll (on a horizontal surface). In total the part of the sheet on which the 
Realmagazine can roll is twice the Base Rotation Size (Base SX + Base DX). 

 
Fig. 3 – Base Rotation = 0% 
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Fig. 4 – Base rotation = 200% 

 

In figures 3 and 4 there are two images, in which the Base is highlighted, with Base Rotation 
respectively equal to 0% and 200%. The 0% position corresponds always to that in which the point 
of contact between the two deformers is placed on the horizontal surface. The other positions 
depend on the values taken as a whole by Ext Strength Bend 1 SX and Ext Strength Bend 1 DX in the 
External Sheet tab. The 200% position is almost always like in the figure 4 where the end of the right 
base bend touches the horizontal surface. 

The animation of Realmagazine is based on two configurations: the starting one and the ending one. 
These configurations have no constraints, they can be freely chosen. For example it will be possible 
to open the magazine only partially or rotate the pages by 360 °. Each configuration is obtained by 
acting on the SX page and the DX page, setting the Strenght Base and the four Strenght Bend. The 
Strenght Base acts on the Base while the following Strenght Bend curve the remaining part of the 
page which is globally divided into five regions. Even the rotation of the Base is essential to define 
the configurations, but this can vary during the animation only using keyframes. 
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Fig. 5 – Bending Area Visibility on 

 

It is possible to activate the display of the bend (fig.5) using the Bending Area Visibility in the External 
Sheet tab so as to be able to view the regions in which the sheet is divided and modify its dimensions. 
The first area is defined by the Base Rotation Size, the next three by the values of Size Bend 1, Size 
Bend 2 and Size Bend 3. The value of "Size Bend 4" depends on the values of the previous Bend and 
therefore is not possible to set it manually. I recommend adding internal sheets only after defining 
the size of the external sheet and the starting and ending configurations. Only after adding the 
internal sheets and distributing them correctly, modifying some parameters if necessary, will it be 
possible to animate the whole magazine using a single slider (automatic animation) or animate each 
page manually to have more control. 
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fig.6 – Fix Base Rotation effects 

In the event that during the animation you would like to rotate the Base it will be necessary, in 
general, to insert keyframes that define the starting and ending configurations so that the shapes 
of the pages adapt to the different values of the rotation of the Base. See the example in figure 6 
where, from top to bottom, you pass from a value for the Base Rotation of 88% to 0%, first without 
changing the configuration of the pages and after making corrections to obtain a plausible result 
with the DX pages resting on the plane surface and the SX pages resting on the DX pages. 

In the Sheets tab there are controls that allow you to have, for the internal pages, starting and 
ending positions different from those of the external page. These are very useful especially when 
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the external page has physical characteristics different from the inner sheets in size and materials, 
as can happen for a cover of an exercise book or a restaurant menu. 

The transition from the starting configuration, during the animation, to the end configuration is 
accompanied by a fold and twist of the page that can be modified in detail by acting on the controls 
present in the Torsion tab. This torsion can be customized differently for each page by accessing the 
controls of the sheet to which it belongs. 

In the RDS (Random Distribution System) tab there are some controls to randomize the distribution 
of the internal pages. 

The Creases tab is useful when you want to insert folds and wrinkles like those of the newspaper 
(fig.7-8). During the animation these deformations work with some limits that I will explain later. 

 
fig.7 - Creases example 1 

 
fig.8 – Creases example 2 
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User Data 

Below I will explain the meaning of all user data given by analyzing each single tab. In this preset 
user data are available either by selecting the parent of the whole preset (GL_REALMAGAZINE) or 
by clicking on one of the sheets - Sheet_x (where x is the index of the sheet) - present under the 
cloner object RM_SheetsCloner. These last user data (fig.9) will be used to get more control over the 
animation of the single page. 

 

 
fig.9 – Sheets user data 

 

Dimension 

Here you can set all the dimensions: the size and thickness of the pages, the distance between them 
and an incremental factor on the width that depends on the index of the sheet, the size of the Base 
(or the bend relative to the Base) on which the Realmagazine rotates , the possible overhang of the 
first sheet with respect to the internal pages. It is also here that you can enter the number of 
subdivisions of the cubes that form the pages, if you want to use the cubes, but I DO NOT 
RECOMMEND IT since the geometry is deformed in a manner that it is necessary to have a number 
of non-linear subdivisions, concentrated where there is the Base and the possible horizontal fold 
(fig.7-8). Finally there is a slider to scale the entire preset and a button that activates the procedure 
to choose the number of sheets. 
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General 

• Page Width = page width (half the width of a sheet). 
• Page Height = page height. 
• External Sheet Thickness = outer sheet thickness. 
• Internal Sheets Thickness = inner sheet thickness. 
• Sheets Distance = distance between pages (center-center). 
• Base Rotation Size = Base size (fold size). 
• Incremental Width = incremental variation of the page width. 

External Sheet Overhang 

• External Width Overhang = overhang along the width of the outer page. 
• External Height Overhang = overhang along the height of the external page. 

Page Subdivision   

In the Page Subdivision group you set the number of subdivisions of the polygons that form the 
pages when the custom ones are not used. In fact it is recommended to set the following values to 
1 if you use custom pages. 

• Width Segments = subdivisions along the width. 
• Height Segments = subdivisions along the height. 
• Scale = scale the entire Realmagazine. 
• Change the Number of Sheets = click this button to set the number of total sheets. 
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External Sheet 

Here are most of the controls useful for creating the start and finish configuration for the animation. 
First of all you can distribute, depending on the final result you want to obtain, the length of the 
four bends following the first one - the one related to the Base - that deform the sheets. I remember 
that the first bend, relative to the Base, equal for both the left and right page has a value that 
depends strictly on the Base Rotation Size and on the External Sheet Thickness in the Dimension tab. 
In this tab, under Sequence of Bend Sizes, the remaining four can be asymmetrically modified. As 
already mentioned, these controls are applied to the external sheet and if in the Sheets tab there is 
no intervention in differential controls then the internal pages will tend to follow the configuration 
of the external sheet. 

Under the External Sheet - Start Position and External Sheet - End Position groups parameters that 
drive the forces of all the bends are defined. They give the shape to the sheet in the two positions: 
the starting and ending position. During animation it will be necessary, to obtain good results, to 
insert several keyframes of these user data so that the starting and ending configuration is always 
perfect, to avoid intersections between pages or suspended sheets. 

It is very important to understand how the controls work. The Ext Strenght Base at 0° bends the 
base 90° and when its value increase the Base opens (fig.10.a-10.b). 

 
fig.10.a - Ext Strenght Base SX = 0° 

 

 
fig.10.b - Ext Strenght Base SX = 45° 
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The Ext Strenght Bend 1 works differently: when its value is o° the page – with the others bends 
below set to zero – points to the right. Higher values make the page rotates clockwise (fig11.a-
11.b). 

 
fig.11.a - Ext Strenght Bend 1 SX = 0° 

 
fig.11.b - Ext Strenght Bend 1 SX = 90° 

 

The others Strenght Bend controls (2,3 and 4) all work the same way. When the value is set to 0° the 
page doesn’t bend in his region. Higher values make the page bends clockwise. 
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• Bending Areas Visibility = You can set the visibility of all the bends that deform the page to 
better understand how each page is divided. 

• Color = you can choose the color of the bend (NB: the color is visible only if in the Render 
tab the cloner object is disabled). 

• Base Rotation = allows you to roll the Realmagazine on the Base. 

Sequence of Bend Sizes 
With the following controls it is possible to change the size of the bends that shape the pages, as 
mentioned in the introduction. 

• Size Bend 1 SX = percentage of page SX used for the first bend net of the length of the Base 
Rotation Size. 

• Size Bend 2 SX = percentage of the SX page remained used for the second bend. 
• Size Bend 3 SX = percentage of the SX page remained used for the third bend. 

The other three controls have the same meaning as the previous controls but for the DX page. 
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External Sheet – Start Position 
Here the starting configuration of the sheet is defined. 

Ext SX Start 
It starts from the SX page 

• Ext Strenght Base SX Start = defines the curvature for the Left Base of the external sheet. 
• Ext Strenght Bend 1 SX Start = defines the curvature for Bend 1. 
• Ext Strenght Bend 2 SX Start = defines the curvature for Bend 2. 
• Ext Strenght Bend 3 SX Start = defines the curvature for Bend 3. 
• Ext Strenght Bend 4 SX Start = defines the curvature for Bend 4. 

Ext DX Start 
Here you can define the starting configuration for the external right page, as above. 

The same controls are present for the arrival configuration within the following groups: 
External Sheet – End Position, Ext SX End, Ext DX End. 

Sheets 

Here are two important parameters: Incremental Bending Base Dimension and Incremental Bending 
Base Strength. These define the way in which the internal pages are distributed inside the outer 
sheet according to two incremental factors that change the size and strength of the fold (or Base). 
They are very important when the Realmagazine is in the closing configuration because they allow 
the space between the two pages of the outer sheet to be filled in the optimal way, that is, until the 
two pages of the innermost sheet touch each other. Below are two examples of the use of these 
two controls (fig.12-13). 

 
Fig.12 – Incremental Bending Base Dimension 
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Fig.13 – Incremental Bending Base Strength 

 

Sheets - Differential Start Position and Sheets - Differential End Position work similarly to the 
corresponding controls for the external page, but they are differential values used by the internal 
pages taking the external page as a reference. If the values are all equal to zero the internal pages 
will follow the trend of the external page otherwise they will differ according to the set values 
(fig.14). 

 
fig.14 – Sheets Differential 
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• Incremental Bending Base Dimension = defines the incremental factor for the size of the base 
of the inner sheets. The inner sheets have the size of the Base less than that of the outer 
sheets. 

• Incremental Bending Base Strenght = defines the incremental factor for the curvature of the 
Base. 

 

Animation 

Here is the control that activates the automatic animation that gives access to the possibility of 
animating in sequence with two sliders all the pages on the left and all the pages on the right. 
Depending on the start and end configuration it is possible to change the order of the sequence in 
which the pages are turned. The Overlap slider is used to choose how much the animations of the 
individual pages overlap each other. Increasing it you can have more pages running at the same 
time. The spline Page Animation Velocity is used to adjust the speed at which the transition between 
the two configurations is made for each page and is always active, it doesn’t matter if Enable 
Automatic Animation is active or not. 
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• Enable Automatic Animation = activates the automatic animation of the pages. 
• Animation SX = it allows to animate the SX pages in sequence starting from the external ones. 
• Invert Order SX = if active it reverses the animation order for the SX pages starting it from 

the innermost page. 
• Animation DX = it allows to animate the DX pages in sequence starting from the external 

ones. 
• Invert Order DX = if active it reverses the animation order for the DX pages starting it from 

the innermost page. 
• Overlap = increasing this value the animations of the individual pages tend to overlap. 
• Page Animation Velocity = the spline defines the speed of the animation of the single page. 

 

 

Torsion 

This tab contains all the settings that adjust the sheet twist during the animation. Understanding 
how its controls work is fundamental to obtaining a credible animation of the individual pages. The 
Torsion Bend Visibility is, similarly to what happens for the Bend, useful for seeing the torsion bend 
in action and being able to manage them better (fig.15). When this setting is active all torsion bends 
will be visible. A very important option within the individual sheets (Active Independent Torsion 
Control For This Page) allows you to make unique for each page the animation of this bend. 
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fig.15 – Torsion Bend 

 

During the animation of every single page the "torsion bend" will be determined through four 
values: position, strength, rotation and size. Each of them will depend on the maximum value that 
it can assume and on the trend of an associated spline that will define its value depending on the 
percentage of animation performed by the page to which it belongs. By doing some tests, the 
mechanism will be easily clarified.  

 
fig.16 - relationship between Open.SX = 20% and Point X of the Torsion Position Animation spline 

Let's see an example for the position value that defines where the torsion bend is located along the 
curve that describes the page. The zero position coincides with the spline point whose Y value is 0.5. 
In figure 16 it is important to note the relationship between the value Open.SX and the value x of 
the spline Torsion Position Animation. When the animation of the SX page is at 20% (Open.SX = 20%) 
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then the point of the spline that defines the position of the torsion bend is the one with the value X 
= 0.2. This value corresponds to the value Y = 0.5 and to this corresponds a position such that the 
torsion bend rests on the edge of the page as shown in the figure 16 and does not modify the page. 

 

 
fig.17 – relationship between Open and Torsion Position Animation values 

 

In figure 17 the relationship between the advancement of the animation of the sheet - represented 
by the numbers in orange - the corresponding point on the spline and the final effect on the Torsion 
Bend is better explained. 

The controls for strength, rotation and bend size work in the same way. The latter is the only control 
that does not foresee negative values, for obvious reasons, therefore the null value is had in 
correspondence of a point of the spline with Y = 0. 
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• Torsion Bend Visibility = activates/deactivates visibility for bends that deal with page 
twisting. 

Torsion SX 

The controls below are all related to the torsion bend on the left page. 

Torsion Position SX 

• Max Torsion Position SX – Global = maximum value of the position. 
• Torsion Position Animation SX = spline defining the position value during the animation. 
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Torsion Force SX 

• Max Torsion Force SX – Global = maximum value of the force. 
• Torsion Force Animation SX = spline defining the force value during the animation. 

 

 

Torsion Rotation SX 

• Max Torsion Rotation SX – Global = maximum value of the rotation. 
• Torsion Rotation Animation SX = spline defining the rotation value during the animation. 

Torsion Dimension SX 

• Max Torsion Dimension SX – Global =  maximum value of the dimension. 
• Torsion Dimension Animation SX = spline defining the dimension value during the animation. 

The controls under Torsion DX work like the previous ones but for the right page. 
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RDS 

This tab contains controls for the Random Distribution System of sheets. We could introduce a 
random factor for the position y, that is, along the thickness, for the position z, that is, along the 
height, for the curvature and the size of the Base. Furthermore, with the Distribution Type it is 
possible to emphasize the difference between the values assumed for a given seed. In figure 18 
there is an example where you can see how the pages are not evenly distributed thanks to the use 
of RDS. 

 

 
fig.18 – RDS example 

 

 

 

• Position y – Random Intensity = introduces random spacing between pages. 
• Position z – Random Intensity = introduces a random variation in the position along the 

height. 
• Strength Random Intensity = introduces a random variation in the strength of the base 

curvature. 
• Base Random Intensity = introduces a random variation in the size of the base. 
• Distribution Type = 0 excludes the random factor, while higher values emphasize the 

differences between random values. 
• Seed = change the random seed. 
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Creases 

In this tab there are some controls that allow to add realism in particular cases, for example in the 
realization of a newspaper (fig.7-8). The first control enables and disables the five controls for the 
horizontal fold that reproduces the one formed when a newspaper is closed and folded in half. 
When the horizontal fold is added then it will be necessary to intervene on another control to avoid 
intersections and an apparent rigidity of the sheets: the Central Lift. This will raise the central part 
of the sheets allowing its ends to rest on the support surface together with the fold, when this is 
pointing downwards (fig.19). 

 

 
fig.19 – Central Lift 

The crumpling has a control that allows only to increase and reduce its intensity. If you wanted to 
modify the distribution, you should modify the Shader Crumpling material present in the preset and 
modify the Color channel layer. When using high values for Central Lift and Crumpling the 



 

 

 23 

deformations can be observed on the textures since the deformers act in the y direction - in the 
Realmagazine system - even when the pages are turning (fig.20). 

 

 
fig.20 – Crumpling distorsion 
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• Enable Horizontal Crease = Enable the horizontal fold. 
• Crease Height = Adjust the height of the horizontal fold. 
• Crease Width = Adjust the width of the horizontal fold. 
• Crease Shape = Adjust the profile of the fold along its length. 
• Crease Lenght = Adjust the length of the fold. 
• Crease Position = Adjust the horizontal fold position. 
• Central Lift = Raise all the Realmagazine in the central area to avoid intersections with the 

support surface due to the horizontal fold. 
• Crumpling = adds the crumpling of the pages. 

 

Custom Pages 

In this tab of fundamental importance you can activate custom pages. Even if the choice is free I 
strongly recommend their use because the type of geometry used in Realmagazine requires more 
polygons especially where there is the Base (or spine) and where horizontal bends are created, if 
you want to implement it (fig. 21). The use of a uniformly divided cube could not offer an adequate 
resolution except at the expense of an exaggerated computational heaviness. You can use the pages 
included in the preset or create new ones that meet your needs.  

 
fig.21 – custom pages in the viewport 

For the correct operation of the preset it is fundamental to insert in Page Dimension When The 
Custom Pages Were Added the dimensions of the custom pages when they are added. The 
dimensions to be inserted, if the pages are not cubes, are those of the boxes that contain them (this 
is very important to avoid artifacts). This will also allow you to change the size of the pages from the 
Dimension tab while keeping the new custom pages that will be appropriately scaled. 
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fig.22 – custom pages in the object manager 

If you wanted to create custom pages from scratch, you will need to respect some important settings 
that you can understand by looking at the custom pages included in the preset (fig.21-22): 

1. Orientation and center of the axes of each page. 
2. Polygon Selection for texturing faces. 
3. SDS Weight tag, created automatically when you weight a Subdivision Surface. It is 

essential if you intend to use the subdivision surface. 
4. UVW Tag if you want to use the UVW Mapping projection. 
5. Stop Tag if the new pages are inserted under GL_REALMAGAZINE as in the preset. 

It may seem complicated, but it's very simple. My advice is to start from a parametric cube, orient 
it appropriately, change its measurements and break it down roughly. Then make it editable and 
make further changes and subdivisions. This way you will also get a usable UVW Tag. The axes of 
the cube are aligned with the following characteristics: 

• Asse x = width. 
• Asse z = height. 
• Asse y = tickness. 

Once the left page is created it is trivial to create the right one (or vice versa), it will be sufficient to 
make a copy and a 180 ° rotation around the z axis. Placing the two pages so that they are contiguous 
as in figure 21 it is clear that if you wanted to use the Subdivision Surface you could have problems 
in the contact area so at this point it could be important to introduce a SDS Weight Tag for the 
Subdivision Surface. For example it is easy to set all the edges in the tag to a value of 100%. Selecting 
them is easy using the Phong Break Selection tool, so just go to the Subdivision Surface tab of the 
Live Selection Tool and press the set button after setting the bar to 100%. Another important step 
could be to remove the overlapping polygons where the two pages are touched (in my tests it was 
not necessary). 
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• Enable Custom Pages = Enable custom pages. 

Page Dimension When The Custom Pages Were Added 

• Page Width Custom = custom page width. 
• Page Height Custom = custom page height. 
• External Sheet Thickness Custom = custom external sheet thickness. 
• Internal Sheets Thickness Custom = custom interna lsheet thickness. 

 

 

• External Page SX = enter the external left page here. 
• External Page DX = enter the external right page here. 
• Internal Page SX = enter the internal left page here. 
• Internal Page DX = enter the internal right page here. 

 

Render 

The Render tab serves to activate some useful functions especially during the rendering phase 
which, if activated during the scene design, can slow down the viewport too much. 

One of these is the Subdivision Surface. Then there are two other checks. The first removes any 
artifacts that may present in particular configurations a bit more extreme, but not too much (fig.23), 
that works thanks to the new Field function of C4D R20. The other control activates the Cloner 
Object, container of all the sheets. This last setting is useful when you want to use the multi-color 
shader to add textures to pages easly. 
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fig.23 – Remove Bend Artifacts 

 

 

 

• Remove Bend Artifacts = removes, when possible, artifacts due to more extreme 
configurations (disable it if not necessary). 

• Enable Cloner Object for Multishader Texturing = activates the cloner object that contains 
the sheets and therefore allows the exploitation of multi-shader texturing. 
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Sheet Object (User Data) 

Each sheet has its own controls that are activated only in certain circumstances. There are two tabs, 
one for the SX page and the other for the DX page. What applies to one tab is also valid for the other. 
Consider the Animation SX tab. The first user data is Open SX. It is easy to guess that this is the 
control that scans the animation between the starting position and the arrival of the single page. If 
Automatic Animation is not active you will need to use this slider to animate each page manually. 
Moreover it is possible to activate the independent control of the Torsion Bend in order to obtain a 
different animation for the left and/or right page of the selected sheet. 

 

 

 

• Open.SX = animates the page from the starting position to the final one (only if Enable 
Automatic Animation is not active). 

• Active Indipendent Torsion Control For This Page = Activate independent Torsion Bend 
control. 

All the controls that follow are identical to the global ones in the Torsion tab. 
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Texturing 

After having seen all the controls concerning the modeling it remains to understand how the 
textures are assigned to the different pages. As written in the introduction, each individual sheet is 
divided into two pages: Page.SX and Page.DX and each page has two sides: front and back. The 
polygon selection that can be used has the following names: 

• Front SX 
• Back SX 
• Front DX 
• Back DX 

So if you want to add texture manually for each sheet you will need to add 4 texture tags and 
associate each of them with the material and add the respective polygon selection.  

 
fig.24 – manual texturing 

For example, in Figure 24 I inserted the same material (with the texture “02”) in the four texture 
tags at the second sheet and each of them was associated with one of the 4 faces. In particular is 
highlighted the third tag in which the Selection field contains the "Front DX" selection visible in the 
viewport. If the rendering engine used allows you to take advantage of the multi-shader mograph 
then you can proceed more easily by creating 4 materials that contain the textures of all the sheets. 
The four materials are so called: 

• SX.Front = contains all the textures for the front and left pages. 
• SX.Back = contains all the textures for the back and left pages. 
• DX.Front = contains all the textures for the front and right pages. 
• DX.Back = contains all the textures for the back and right pages. 

So for example if we start counting pages from scratch and insert 4 sheets each material will contain 
the pages in the multi-shader as indicated below: 

• SX.Front = 0,2,4,6 (fig.25). 
• SX.Back = 1,3,5,7. 
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• DX.Front = 8,10,12,14. 
• DX.Back = 9,11,13,15. 

 

 
fig.25 – multi-shader example 

It is important to note that the multi-shader mode for SX pages is set to Index Ratio while for DX 
pages it is set to Color Brightness. This must be for the setup to work properly. 

Staples 
In case you want to introduce some staples as you can see in the first image of the manual, simply 
insert them under the null object "Insert the Staples Here" and they will automatically follow the 
movement of the base. In the preset I inserted two example staples. You can then delete, modify, 
move or replace them with others you have created.   
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Conclusion 

I thank those who managed to get here or who just missed everything to read these conclusions. I 
hope I have illustrated to the best the fundamental characteristics for a simpler and immediate use 
of this preset and I hope that this work can be of your pleasure. 

 

 

 

To report any problems, to share jobs or for any other information, write to me at: 

info@giannilorusso.com 

Or contact me here:  

            https://giannilorusso.com/  
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